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01Library Tutorials

1.1 How to Add a New Machine

1. Open the Machine Library
Open the Machine Library from the Dragon CAM Task Menu.

2. Click Add New
Click the ADD NEW button. This will open the Add New Machine Wizard.

3. Select the Machine Model
Select the appropriate Dragon model. Click NEXT. For adding a Dragon A400 continue to Step 
4. For adding a Dragon A250 skip to Step 6. For adding a Dragon A150 skip to Step 7.
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Important
A warning will appear when selecting the Dragon A250 or Dragon A400. When 
adding a new machine, it is recommended to CLONE the Factory Calibrarted 
Machine and use those values as a starting point. 

4. Dragon A400 - Select the Machine Length and Tube Capabilities
For the Dragon A400, select the Machine Length and Tube Capabilities. Click NEXT.

Important
Only Dragon A400 machines equipped with a Powered Gate can accomidate 
L-Channel (Angle Material) and U-Channel (Channel Material). The Dragon A400 
does not support Flat/Bar material.

5. Name the Machine and select Options
Give the new machine a descriptive and unique name. Select the appropriate Unit of Measure 
to use. Select any optional features that the new machine includes. Click DONE. Continue to 
Step 9.
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6. Dragon A250 - Name the Machine, select Length, and Unit of Measure
For the Dragon A250, select the Machine Length, Unit of Measure, and give the machine a 
descriptive and unique name. Click DONE. Continue to Step 9.

7. Dragon A150 - Select Machine Length and Tube Capability
For the Dragon A150, select the Machine Length and Tube Capability. Click NEXT.

8. Name the Machine and select Options
Give the machine a descriptive and unique name and select the appropriate Unit of Measure. 
Please note, the Dragon A150 does not support a Powered Gate or Center Support option. 
Click DONE.
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9. Click Save
The new machine information will populate into a new temporary record in the Machine Library. 
Click SAVE to add the new machine to the Machine Library.

9. Adjust other Settings
Once the new machine has been saved to the Machine Library, the other machine settings can 
be edited as desired.

1.2 How to Add a New Material

1. Open the Material Library
Open the Material Library from the Dragon CAM Task Menu.

2. Click Add New
Click the ADD NEW button. This will add a new blank record to the Material Library.

General Tab Information

3. Name the Material
Give the new material a descriptive name. 
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4. Select the Unit of Measure
Select the appropriate Unit of Measure.

5. OPTIONAL. Record the Material Weight
Record the Weight per Inch of the material. This is used for pricing projects and is not 
necessary for operation.

6. OPTIONAL. Choose the Material Color
Select a color for the material. This will change the color of the material during part design and 
is not necessary for operation.

7. Choose the Material Profile
Select the Material Profile. The Dragon A400 supports Round, Square, and Rectangle. Dragon 
A400’s equipped with a Powered Gate also support Angle and Channel. The Dragon A250 only 
supports Round material.

Important
Flat Bar may be listed as a material profile option. The Dragon machines are 
not programed to cut Flat Bar at this time, and Bend-Tech does not recommend 
cutting Flat Bar material on the Dragon machines. 

8. Input the Material Dimensions
Fill in the correct dimensions for the selected material. If dimensions are unknown, use a 
calipers, tape measure, and corner radius gauges to obtain the dimensions. 
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Machine Tab Information

9. Navigate to the Machine Tab
Edit the Machine specific information for the material. Most of these settings can be left as 
default.

Lead In / Out Information
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11. Navigate to the Lead In / Out tab.
Select the style of Lead In and Lead Out to be used as default for the material. Unless the 
material is Angle or Channel, Perpendicular Lead types can be used for both End Cuts and 
Internal Cuts. For Angle and Channel material, Bend-Tech recommends Angle.

NRC, Pricing, and Advanced Information

12. Adjust Other Settings
The options available on the remaining tabs are optional. Refer to the Operator’s Manual Part 
1, Sections 2.6 - 2.8 for detailed information.

Saving the Material

13. Save the Material
Once the settings are completed and set appropriately, click SAVE.

1.3 How to Add a New Die

1. Open the Die Library
Open the Die Library from the Dragon CAM Task Menu.

2. Click Add New
Click the ADD NEW button. This will add a new blank record to the Die Library.

3. Start the Die Calibration Wizard
Click the WIZARD button to begin adding a new die. The Die Wizard will walk through 
calibrating the die.

4. Read the Calibration Introduction
After reading the introduction to the Die Wizard, click NEXT. 

5. Select the Bender Model
Select the model of the bender being used from the drop down menu. If the bender model is 
not listed or unknown, select the model based on the type of bender: ‘Any Rotary Draw’, ‘Any 
Rotary Compression’, or ‘Any Center Compression’. Click NEXT.
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6. Enter the CLR
Enter the Center Line Radius (CLR) of the die. This value is usually stamped on the die. Do not 
confuse the CLR with the material diameter of the die. Click NEXT.

What is Center Line Radius?
By definition, Center Line Radius is the distance from the center of the bending die to the 
middle of the tube. The smaller the die, the shorter the Center Line Radius, the tighter the 
bend. 

Important
If using standard measurement, ensure the correct Unit of Measure is used. 
Many dies are stamped in millimeters.

7. Enter the OD of the Material
Enter the outside diameter of the test material. Click NEXT.

Pipe vs. Tube
Pipe is designed to carry things through it, such as liquid or gas. Pipe is sized by its I.D. Tube 
is structural, and is designed to build. Tube is sized by its O.D.
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8. Enter the Length of the Material
Enter the length of the material being used. Ensure that the piece is long enough to create a 
90 degree part with the die being calibrated. Click NEXT.

9. Mark the End of the Tube
Mark the end of the tube a few inches from the end. Enter the distance from the end of the 
tube to the mark into the text box. Bend-Tech recommends 3 - 4 inches. Click NEXT.

10. Bend the Tube
Bend the tube to 90 degrees. Ensure that after bending the part is within 1 degree of 90 
degrees. The part may need to be over-bent to compensate for spring back. Click NEXT.

11. Measure the First Leg
Measure the height of the first leg and enter the value into the text box. Click NEXT.



14 Bend-Tech Dragon

Library Tutorials01

Operator’s Manual: Tutorials & Calibration

12. Measure the Second Leg
Measure the height of the second leg and enter the value into the text box. Click NEXT.

13. Add the Calibrated Die
The calibration results are listed on the next screen. Click ADD DIE. If the calibration has no 
errors, a popup will appear. Enter a unique and descriptive name for the die. Click OK.

Another popup will appear stating that the Die has been added to the Die Library. Click OK and 
close out of the Die Calibration Wizard. The new die will now be listed in the Die List.

1.4 How to use Rotation Calibration Wizard

The Rotation Wizard calibrates the Bend Rotation Offset. The Rotation Wizard will calibrate the 
machine to place bend marks that compensate for bender configuration. 

1. Open the Die Library and Select a Die
Open the Die Library and select a die from the Die List. 

2. Start the Rotation Calibration Wizard
Navigate to the Bend Marks tab and click the Rotation Wizard button. The Rotation Calibration 
Wizard will appear. Click NEXT. 
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3. Select the Machine and Material
In the Rotation Calibration Wizard interface, the die will already be selected. Select the 
machine and select the material. Click NEXT. 

4. Select the Bender model
Select the model of bender, click NEXT. 

5. Enter the Length of Material needed before the bend
Enter the amount of material needed before the start of the bend in order for the bender to hold 
the material. Enter this value in the text box. Click NEXT. 
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6. Enter the Material Length
The software will display the minimum required part length that can be used for the calibration 
process. Ensure the part being used for the Rotation Calibration Wizard process is long 
enough. Enter the length of the material in the text box. Click NEXT. 

7. Send to Machine
The software will automatically program the Dragon to perform the required operations to carry 
out the Rotation Calibration Wizard. Click SEND TO MACHINE. 

8. Press Start and Load the Material
Press START on the Machine Control interface. Load the material into the machine, tighten it 
in the Chuck, and ensure the Gate jaws are snug to the material. 
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9. Press Start
Click START a second time on the Machine Control interface. The Dragon will cut and mark 
the material appropriately. 

10. Bend the Part
During the cutting and marking procedure, the machine marks a crosshair on the material. Line 
the crosshair up with the start of the die. Bend the part to 90-degrees. Click NEXT. 

11. Measure the Rotation of the Start Cut
Place the part on a flat surface such as a table. Ensure the bent piece of material is vertical to 
the flat surface. Place a second piece of material in the cope and measure the degree of the 
material in relation to the table as shown in the diagram. Enter the measured value in the text 
box. Click NEXT. 

12. Ensure the Part Visually Matches the Calibration Image
The next interface will display a 3D image of the part showing bend rotation. Rotate the part 
using the computer mouse. Ensure it visually matches the calibration and the actual part. Click 
NEXT. 

13. Finish the Calibration
The final interface will display the Rotation Offset. Depending on the rotation direction of the 
bender, the final value will be either 270-degrees or 90-degrees, or a value close to one of 
these. If the value does not match, the software compensates for that. For example, if the final 
value is 272-degrees, the machine will compensate for the two-degrees. 

Click FINISH to apply this to the selected die. The software will use this calibration information 
to correct for bend rotation when processing material.
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1.5 Side Offsets Calibration

Square, rectangle, angle, and channel materials have measurable sides which makes the 
procedure for setting up these materials in the Dragon A400 CAM software different than 
setting up round material. The following process will walk the operator through the Side Offsets 
Calibration procedure for square material. The process for settings up rectangle, angle, and 
channel material will be similar. 

1. Open Dragon CAM
Open the Bend-Tech Software and select Dragon CAM from the menu.  

2. Add Material 
The material will need to be added to the Tube 
/ Pipe Library before continuing with the Side 
Offsets Calibration. Select the Tube / Pipe Library 
from the Task Menu and add the new material. 
Click SAVE.

3. Chuck Grip Settings
Before proceeding with Side Offsets Calibration, 
it is important to ensure the Chuck Grip option 
is set appropriately for the type of material being 
calibrated. 

Select the material being calibrated and navigate 
to the Machine tab. Select the appropriate 
CHUCK GRIP option from the drop down menu 
in the Basic Settings section. To reference which 
Chuck Grip to choose, click the question mark icon 
next to drop down menu for a visualization of the 
different options. 

4. Corner Rotation Extension
Corner Rotation Extension is the distance before the tool reaches the corner of the material, 
prior to the material rotating. It simulates a larger corner radius, which can ensure that the 
Torch avoids cutting parallel to the inner wall of the material. If the Corner Rotation Extension 
is not set correctly it can lead to Torch collision, or the Torch cutting vertically into the wall of 
the material. It can also cause Torch failure. 

Select the material being calibrated and navigate to the Machine tab. Locate the Corner 
Rotation Extension text field. Use the formula to calculate the value to enter in the DISTANCE 
text box. 
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Corner Rotation Extension
If the Corner Rotation Extension value is negative or less then .1, leave it set to 0.

Formula
(wall thickness + kerf) - radius = Corner Rotation Extension

For example, if the wall thickness is .120, the kerf width is .06, and the radius is .15 
the Corner Rotation Extension will be .03. Since this number is less than .1, leave the 
DISTANCE setting set to 0. -- [(.120 + .06) - .15 = .03]

5. Open Side Offset Calibration
Select the material being calibrated and navigate to the Advanced tab. Locate Side Offsets and 
click CALIBRATE. This will open the Side Offsets Calibration Wizard.

6. Disable Feature
The first page of the calibration wizard will give the operator the option to Disable the Side 
Offset Calibration feature and use the machine’s default measurements. Bend-Tech requires 
performing the Side Offset Calibration to achieve more accurate results when cutting square, 
rectangle, angle, or channel material. Do not disable the Side Offsets Calibration feature if 
accurate cuts are required. Click NEXT. 
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7. Select the Machine
Select the machine being used for the calibration from the drop down menu. Click NEXT. 

8. Start Mach3
Ensure the machine is powered on. The wizard will then prompt the operator to start Mach3 
Click START MACH.
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9. Homing Procedure
The next page of the wizard goes through the homing process. To begin, click the image on 
screen. Text will appear informing the operator that the ‘Machine is currently homing, please 
wait’. After the Homing process is complete the text will disappear; click NEXT. 

10. Load the Material
Enter the length of the material being used for the calibration. The Side Offsets Calibration 
should use a piece of material between 3 ft. and 6 ft. in length. Click BEGIN LOAD. This will 
move the Trolley into Load Position, so that the material can be loaded into the machine. 
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Load the material into the machine. Chuck it up securely using spacers as needed. Square 
material will not require spacers but rectangle, angle, and channel material will. See the 
information regarding Material Spacers for more information. 

After chucking up the material, adjust the Gate. Tighten the Gate Rollers so that they are snug 
but not tight against the material. The rollers should be able to be rolled by hand with no play in 
the material. Before continuing, return the Gate Lead Screw positions to the 12 o’clock and 3 
o’clock positions. Click NEXT.

Material Spacers
Rectangle, Angle, and Channel material require spaces to be used when chucking the 
material into the Dragon A400. Use solid stock material like aluminum blocks to center 
the material in the Chuck. 

Important
The machine grounds through the Chuck. Ensure that a minimum of two sides of 
the material or metal spacer connect with the chuck teeth.

Rectangle Material Spacers. 
When loading rectangle material, spacers are needed to center the material in the 
Chunk. Use the following formula to determine the height of each spacer. 

Formula
(Long side of the material - the short side of the material) / 2

For example, for 2” by 6” material will result in 2” spacers. -- [(6 - 2) / 2 = 2]

Angle Material Spacers
When loading angle material, the operator will need to use a spacer to ensure the 
material is securely clamped in the Chuck. This may require fabricating a piece that fits 
the material. The spacer should fit the angle material so it essentially creates a square.

Spacer

Width

Height

Material Thickness

Formula
Size of material - material thickness

For example, if the material is 2 in. angle, 
and is .25 thick, the spacer would measure 
1.75 in. x 1.75 in.

[2.0 - .25 = 1.75]
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11. Torch Distance
The next section of the Calibration involves measuring and recording the gap distance 
between the Torch and the surface of the material. Click MOVE TORCH. This will move the 
Torch into position for the first side (A) of the material. 

Use a set of feeler gauges to measure the distance between the Torch and the material. 
Measure the feeler gauges with a Vernier calipers. Record the measurement for the GAP 
DISTANCE in the provided text field. Click NEXT. 

Channel Material Spacers
When loading channel material, the Operator will need to use a spacer to ensure the 
material is securely clamped in the Chuck. This may require fabricating a piece that fits 
the material. Channel material will have a spacer above and below the material. 

Width

Height

Top Spacer

Material Thickness

Bottom Spacer

Formulas
Bottom Spacer: ((Width - Height) / 2)

Top Spacer: (Bottom Spacer + (Height - 
Material Thickness))

For example, if the material is 3 in. x 2 in. 
channel, and is .25 thick, the top spacer 
would measure 2.25 in. and the bottom 
spacer would measure .5 in. 

[(3 - 2) / 2 = .5] and [.5 + (2 - .25) = 2.25]



24 Bend-Tech Dragon

Library Tutorials01

Operator’s Manual: Tutorials & Calibration

The machine will automatically move to the next side of the material. Perform this 
measurement for all sides of the material. 

12. Run Test Cuts
The machine will now perform a test cut based on the Torch height values entered by the 
operator. The default values for Pierce Height, Cutting Height, Feed Rate, and Hole Size 
should be appropriate for the material being used because they are based off of the material 
information, but can be adjusted if needed. 

Click RUN to start the cutting process. When the machine finishes cutting out the calibration 
part, click NEXT.
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13. Measure Test Cuts
The program will ask the operator to measure the distance of the left hand and right hand side 
of the hole to the edge of the material. 

Use the image on the interface as a reference regarding which side to measure. Enter the 
appropriate values in the text boxes. Click NEXT.

Perform this measurement for all sides of the material. After performing this for all of the 
necessary sides, click NEXT.
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14. Verify Test Cuts
The calculated offsets will appear on the screen. To verify that these are correct, click VERIFY. 
The machine will perform the test cut procedure again.

Once the second test part is finished cutting, verify that the holes are centered on each side 
of the material. If the holes are still not centered after the second test cut. Click GO BACK to 
repeat the calibration process. If the holes are centered, click FINISH.

 

13. Save Calibration
Once the calibration is finished, the program will return to the Tube / Pipe Library. The SIDE 
OFFSETS will now display the calibrated values determined during the Side Offset Calibration. 

Click SAVE to record the calibration values for that material. These values will be used every 
time the calibrated material is run through the machine.
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02Part Design Tutorials

2.1 Create a Straight Part

This tutorial will go over the basics for creating a 12-inch part with a cope on one end, a 
45-degree miter on the other, a grid of 4 evenly spaced round holes, and a square pass 
through hole.

1. Open Create Straight Part
From the Bend-Tech CAM Task Menu, select STRAIGHT. This will open the Straight Part 
Designer. 

2. Select the Material
Select the part material from the MATERIAL drop down menu. The material needs to be added 
to the Tube / Pipe Library before it can be selected.

3. Name the Part
The Part Name will default to ‘New Straight Part’. For this tutorial, change this to ‘Tutorial Part’. 
This will appear as a Part ID that can be marked or engraved in Edit Flat.
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4. Enter the Tube Length
Enter the Part Length in the TUBE LENGTH text box. This is the length of the part, not the 
stock length. For this example 12 inches.

5. Add the Cope End Cut
Navigate to the Cutting Tab. Click the ADD button to add a Cope to the start of the part. Leave 
the other settings as default for the purpose of the tutorial. 
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6. Add the Miter End Cut
Click the ADD button to add a second cut to the end of the part. Click the TYPE button, or 
double click the TYPE cell on the Cutting Table, for the end cut to change the cut to a Miter. 
Leave the other settings as default for the purpose of the tutorial.

7. Add the First Round Hole
Navigate to the Holes Tab. Click ADD. From the Hole Type pop-up menu, select ROUND. 
Change the DISTANCE to 2. This will adjust the hole location to be 2 inches from the start of 
the part. Leave the rest of the settings as default.
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8. Add the Rest of the Holes
Next, click GRID. This will open a pop-up interface used to grid out series of holes. NUMBER 
OF COLUMNS adjusts the number of holes along the length of the part. Set this to 4. 
SPACING BETWEEN COLUMNS adjusts the distance between the column holes. Set this to 
2.5”. NUMBER OF ROWS is the number of holes around the material. Set this to 1. Leave the 
other settings as their defaults.

8. Add the Square Hole
Click ADD and select SQUARE from the Hole Type pop-up menu. Set the MEASURE FROM 
option to End of Part. Enter 1.5” for the DISTANCE. Set the ROTATION to 90 degrees. Check 
the CREATE OPPOSITE HOLE. 

9. Save the Part
Once the part is completed, go to File > Save As to save the part. From here the part can be 
set to the Flat Designer for further edits or the Nest Part to create a nesting project that can be 
sent to the Dragon machine for cutting.
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2.2 Create a Bent Part

This tutorial will go over the basics for creating a 3-foot long part with 2 bends rotated 
180-degrees from each other, with copes on both ends.

1. Open Create Bent Part
From the Bend-Tech CAM Task Menu, select BENT. This will open the Bent Part Designer. 

2. Select the Material and Die
Select the Material from the drop down menu. This material will need to be added to Tube / 
Pipe Library before it will be available as an option from the list. Select the Primary Die that will 
be used in making the part from the drop down menu. The Die(s) will need to be added to the 
Die Library before it is available to select from the list.

3. Name the Part
The Part Name will default to New Bent Part. Change this as necessary.

4. Set the Number of Bends
Select the Number of Bends needed from the drop down menu. For this example, 2 bends are 
needed.

5. Set the Starting Angle
For this part, the STARTING ANGLE can remain at 0-degrees. If a part needs a specific 
starting angle, enter the angle into the text field.
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6. Enter the dimensions of the Part
After the number of bends are selected, a table will appear below the Die & Material Tab. Fill 
in the dimension of the part, leg lengths, bend rotations, and bend angles. If the part requires 
the use of multiple die sizes, select the specific dies from the drop down menus. The Part will 
appear in the 3D Display Interface once all the dimensions are entered. 

For this part, enter 12-inches for all three LENGTHS. First ROTATION is 0-degrees and 
second ROTATION is 180-degrees. ANGLE is 90-degrees for both. 

7. Add End Cuts
Navigate to the Cutting Tab to add End Cuts to the part. Click ADD to add the Start Cut. This 
will default to a cope. Click ADD a second time to add an End Cut.
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8. Send to Edit Flat or Nest Part
Once the bending information in entered and the part that appears in the Display Window looks 
accurate, the part can be sent to either Edit Flat or Nest Part. EDIT FLAT is used for editing 
in custom geometry or adding/removing a Part ID. NEST PART is used to nest the part onto a 
stick for cutting on the Dragon machine.

2.3 Custom End Cuts

This tutorial will go over how to create a part with a custom end cut, such as a cope with a 
notch. To begin, open Bend-Tech CAM and click STRAIGHT from the Task Menu.

1. Create the Base Part
Select round material of any size. Enter an appropriate TUBE LENGTH.

2. Add a Cope
Navigate to the Cutting Tab. Add a Cope to the start of the part. 

3. Open in Edit Flat
Click the EDIT FLAT button from the menu 
at the top. This will open the part in the Flat 
Designer which is used to add/edit custom 
geometry.

4. Add New Geometry
Navigate to the Create Geometry tab and 
select the Holes tab. Add a round hole to the 
center of the Cope using Free Select.

5. Edit Geometry
Under Actions, click the Edit Tab. The 
Edit Tab is used to edit or remove current 
geometry.

Tip
When unique or non-typical geometry has been created, the software may not recognize a 
programmed cut properly. This may cause errors such as the software choosing cut paths that 
contradict each other. When this happens the cut actions will need to be reassigned. 
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6. Delete Actions
Click the Remove icon, then click each action 
in the Actions Panel that need to be removed. 
When actions are removed, the cutting 
indicators will disappear and the part will be 
displayed as simple lines.

7. Break the Line at the Intersection
Navigate to the Trim tab located under Edit 
Geometry and select Break Both. Next, select 
the first line of the intersection, followed by 
the second line. This will break the lines at 
the intersection. Do this for all intersections.

8. Delete Unneeded Lines
To delete the lines that are no longer 
needed for the new geometry, select Delete 
and use the options available to delete all 
unnecessary lines. 
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9. Create a New Cut
Return to the Actions Tab, open the Create 
Tab. Click Start Cut, then click on the new 
geometry to create a cutting path. 

If the geometry is done properly, the software 
will populate a new cutting action. 
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03Text and Part ID Tutorials

3.1 Adding a Part ID

In Edit Flat, a Part ID can be added to the part and programmed to be marked, engraved, or 
cut during production.

1. Open a Part in Edit Flat
Open or Create a new part in Dragon CAM. Open it in Edit Flat by clicking the button at the top 
of the screen. Remain on the Part Data tab. 
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2. Adjust the Location X and Location Y

Edit the value in the Location X text box to position the Part ID on the material from the start of 
the part. Edit the value in the Location Y text box to position the Part ID on the circumference 
of the material. 

Note
The Y Value Format  is used to choose the type of measurement the software uses to program 
how the machine places the text on the circumference of the part. Perimeter Distance will place 
the text from the start of the part as viewed in Edit Flat, Rotation Degrees will place the text 
according to Y Axis rotation. 

3. Adjust the Angle
Enter the angle at which the Part ID should appear on the material in the Angle text box. A 
value of 0 will align the text lengthwise along the material. 

4. Adjust the Size of the Text
Enter the size of the font as it should appear on the material in the size text box. The part 
display interface will size the text accordingly on the part. This will give the operator a visual of 
the size of the text in relation to the part. 

5. Set the Action type
In the ACTION drop down menu, choose how the machine will apply the Part ID to the 
material. Typically the Part ID will be set to Mark or Engrave. 

6. Change the Text
In the TEXT text box, enter the text that should appear on the material. This defaults to the 
Part Name that was created during initial part creation.
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7. Select the Font

Choose the desired font that will be used with the Part ID from the font drop down. Bend-Tech 
recommends either __Arial or __Time New Roman since they are single-line fonts.

8. Set the Part Name
At the bottom of the interface, choose a name for the part by typing the desired name in the 
text box under Part Name. The Part Name is not necessarily the same as the Part ID. This 
defaults to the Part Name that was created during the initial part creation.

3.2 Placing Text on a Part

It is not uncommon for designers to include additional text on the part aside from a Part ID. 

1. Open Edit Flat
Open or Create a new part in Dragon CAM. Open it in Edit Flat by clicking the button at the top 
of the screen.

2. Open Create Geometry
With the part open in Edit Flat, click the Create Geometry Tab.

3. Identify the Location for the Text
Before placing the text, a placement point needs to be identified. Use CURSOR to place 
a point at the cursor location. To place the text at a specific position, use the various other 
methods available. 
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ABSOLUTE, for example, will set the text at a specific point according to the X-Axis and 
Y-Axis. The distances are measured from the lower left corner of the part. Click APPLY to set 
the point.

4. Create New Text
To create text, open the Text subtab and click the NEW icon. Under Text Properties, type the 
text that will appear on the part into the TEXT text box. Choose the desired Font Family, Font 
Size, and Letter Padding. Letter Padding adjusts the spacing between letters. 

Polyline lettering is recommended for engraving or marking text. Bend-Tech Dragon Software 
comes with two polyline fonts: __Arial and __Times New Roman. These are found at the top of 
the drop down font list.

5. Place the Text
Click to place the text onto the material. If a specific point was chosen under the Point tab, 
place the text on that point. The text can be placed using Free Select if it does not need to be 
placed at a specific point.

6. Convert the Text
Click CONVERT TEXT, then click on the text that was created. Convert Text turns the text into 
lines and arcs the cutting software recognizes. This is required in order to apply Actions.

3.3 Placing Bridge Cuts

When cutting out text, bridge cuts are required on letters that have pieces that may drop out.
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1. Placing Bridge Locations

Before placing Bridges, points need to be set. These points will serve as the center point of the 
bridge. Navigate to the Create Geometry > Point Tab. Use CURSOR to set the center point of 
each bridge that is needed.

 
2. Navigate to the Bridging Tab

Navigate to the Edit Geometry tab. Open the Bridging subtab.

3. Set the Dimensions
Set the dimensions for the bridge such as Width, Length, and Angle. Adjust the settings to 
achieve the appearance desired. 
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4. Place the Bridge

With the settings chosen, two lines will appear alongside the mouse cursor. If the lines appear 
at the correct width and angle according to the dimensions for the bridge, click on the desired 
letter to place the bridge in the appropriate place. 

 
5. Apply Polyline Cut Actions

Navigate to the Actions Tab, click POLYLINE CUT. Click each letter to apply the Polyline Cut 
action. A “Process Name” popup will appear after each Polyline Cut is applied. Use the default 
name, or enter a name for the action if desired. Click OK. 
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Important
It is recommended to use Polyline Cut for actions such as letters. Lead-Ins are 
used with Cut Outs, which is not necessary and could affect the quality of the cut.

6. Nest Part
Click Nest Part. The part is now ready to be cut on the Dragon. 
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04Internal Cut Tutorials

4.1 Creating a Series of Holes

The Grid feature is used to create a series or line of holes in Dragon CAM. This is a helpful 
feature when creating hand rails where the part designer may want to create multiple holes 
at a fixed size and distance. This is also helpful when the project requires the part designer to 
countersink certain features of the design. 

1. Open the Holes Tab
With a part open in the Dragon CAM Part Designer, click the Holes tab.
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2. Add a New Hole
Click the ADD icon. It should be the only icon not 
grayed out in the interface. 

When ADD is clicked, an Add New Hole popup will 
appear. From the dropdown menu, choose the type 
of hole that needs to be created. Click OK.

3. Select the Measuring Point
In the MEASURE FROM dropdown, choose the 
measuring point where the holes should begin. 

4. Set the Hole Location
In the DISTANCE text box, enter the distance the holes should begin from the Measure From 
point chosen in the previous step. 

5. Adjust the Settings
Adjust the hole settings until the desired shape, angle, size, and rotation are correct.

Hole Settings
• In the Width text box, enter the desired Width, or diameter of the hole.

• To place holes on a different rotation than a cope or miter cut, enter the Rotation value 
in the Rotation text box. Rotation can be entered as Degrees or linear Travel. 

• If cutting square, rectangle, angle, or channel, enter the Corner Radius of the material. 

• If creating plunge holes, enter Plunge Angle and Plunge Depth in the text boxes. 

• If passthrough holes are needed, or two sets of holes 180-degrees apart on the 
material, click Create Opposite Hole.

6. Setting the Holes to a Grid
Click the GRID icon. A Create Hole 
String/Grid pop-up will appear. Two 
different sets of data can be entered in 
the pop-up. NUMBER OF COLUMNS 
will be the number of holes created 
along the length of the material, such as 
when creating railing pickets. 

SPACING BETWEEN COLUMNS 
is the spacing between the holes, 
measured on center. 
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NUMBER OF ROWS will be the number of rows of holes created on the material, such as 
when pickets need to pass through a material it would require two rows of holes. 

SPACING BETWEEN ROWS is how far the rows are spaced apart on the material. In the 
Row Spacing box within the Create Hole String/Grid popup, choose Distance or Degrees 
regarding how rows are spaced around the circumference of the material. Once the desired 
values are entered in the text boxes, click OK. 

Important
If a mistake is made when adding gridded holes to the part, such as wrong size or 
spacing, each hole will need to be highlighted and deleted. click REMOVE to delete 
the highlighted holes and re-enter the correct values. 
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4.2 Slot & Tab

A unique feature of the Dragon machines is the ability to create Slot and Tab. The Slot and Tab 
feature makes putting assemblies together for mock-up and welding easier. Slot and Tab also 
ensures accurate placement of parts when putting assemblies together. Ensuring that Slot and 
Tab is done properly is key to creating professional assemblies with the Dragon. Slot and Tab 
can only be created in Dragon CAD.

4.2.1 Creating Slot and Tab

1. Open Dragon CAD
Open or design an assembly in Dragon CAD. 

2. Create a New Cut
Select the Cutting tab, then click New Cut. The software will prompt the user to select the 
feature in the 3D interface that is being cut. Click on that part. 

3. Select the Tubes to Slot and Tab
The program will then ask the user to select the tube(s) that will determine the cutting profile. 
This is the material the New Cut will be profiled to fit. Once the profile tube is selected, click 
complete. 
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The interface will now display the cut in the assembly. The software has added a cope to the 
selected material. The next step is to create a Slot & Tab.

      

4. Add Slot & Tab
Click Add Slot & Tab from the Cut Settings options and click New Cut. Repeat the procedure of 
selecting the feature to cut and the tube that will determine the cutting profile. Click Complete. 

The interface will now display the Slot & Tab.

5. Change the Display
At the top of the interface click Display. This will change the wire frame and line view to a 
shaded view of the parts, which is easier to see the completed cuts.
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Click the Parts tab at the top of the box next to the 3D parts display. The user can check and 
uncheck the parts, next to the part names to view them individually. When this is done the part 
can be viewed with the Slot & Tab cuts visible. 

5. Moving the Slot & Tab Location
When the Add Slot & Tab in checked under the Cut Settings options, a text box will appear next 
to Add Slot & Tab with a zero in it. The user can change the value in this text box to move the 
location of the Slot & Tab around the circumference of the cope. The software automatically 
places the tab at the bottom of the cope. Changing the value to 90 will move the tab to one of 
the high sides of the cope. Entering 180 will move the tab to the low side on the opposite side 
of the cope, and so on. 

4.2.2 Changing Slot & Tab Dimensions
The user can change the dimensions of the Slot & Tab assembly to create a closer fit or to 
increase or reduce the overall size of the Slot & Tab. 

1. Open the Tube / Pipe Library
In the Dragon CAD interface, in the Tools drop down menu, click Tube / Pipe Library. In the 
Material List choose the material that is being used. 
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2. Open the Advance Tab
At the top of the screen click the Advanced tab. In the Advanced interface, under the Slot and 
Tab section, there are four Slot and Tab values. 

3. Adjust the Slot & Tab Settings

The TAB WIDTH is the width of the tab that will extend into the slot in the adjoining tube. The 
default value will be 0.25 inches. The user can leave this value as-is. However, Bend-Tech has 
found 0.2 inches to be a better value for TAB WIDTH. 

Add the Tab Width value to the Kerf Width value and enter the value into the SLOT MINIMUM 
HEIGHT. If the Tab Width is .2 inches and Kerf Width is .06 inches, the Slot Minimum Height 
would be .26 inches.

The TAB LENGTH OFFSET value is the overall length of the tab, or how far it extends into 
the slot. The default value for Tab Length Offset is .25 inches and Bend-Tech has found this to 
be a good starting point for most applications. 

The SLOT WIDTH OFFSET is the amount the slot width will be cut oversize in relation to the 
Tab. Bend-Tech has found .08 inches to be a good starting value for Slot Width Offset. 

4.2.3 Transfer the Slot & Tab Assembly to Dragon CAM

1. Verify that all Parts are Ready for Transfer
On the left hand side of the interface, under the Parts tab, ensure all the parts ready to be 
processed in the Dragon are checked. 
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2. Transfer to Dragon CAM
At the top of the interface, click the Transfer drop down menu. Click Dragon CAM.

3. Open Dragon CAM
In the menu bar at the bottom of the computer screen click the Dragon icon. This will open 
Dragon CAM. Dragon CAM will display a Part Transfer interface showing the parts that were 
transferred from Dragon CAD. 

4. Open the Part Designer
Click the Designer icon at the bottom of the interface. A “Select Machine” interface will open, 
ensure the desired Dragon machine is selected. Click OK. The parts will appear as a Design 
Project. The software will create multiple Design Project windows depending on how many 
parts are being created. 

The part with the Slot will display a saddle mark that will be drawn on the material using the 
Marker tool.
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4.3 Adding a Notch

Notches can only be cut on the Dragon A400 machine. Notching a tube is used to fold a 
square or rectangle tube to a specific, squared-off angle. This process involves programming 
the Dragon A400 to make a cut in the material that removes parts of three sides of the tube, 
leaving one side intact as the outside corner of the bend. Notching is helpful when pieces of an 
assembly are cut and assembled at different locations. 

4.3.1 Creating a Notch in Dragon CAD

1. Navigate to the Cutting Tab
With material displayed in Dragon CAD Assembly, click the Cutting tab.

2. Open the Holes Tab
To create a Notch in the Cutting interface, click the Holes tab. 

3. Select Notch
In the Hole Shape box select NOTCH. Default notch dimensions will appear in the Notch 
Dimensions box. 

4. Select Create Hole
Select Create Hole. When the cursor is moved over the part display, the software will display a 
message that reads, “Select the part to create a hole.” Click the part that will receive the notch. 

5. Select the Hole Center Point
The software will then display a message that reads “Select the center point of the hole.” Bend-
Tech recommends plotting cuts using pick points. Select the pick point that marks the location 
of the notch. 
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6. Select the Rotational Direction Point
After selecting a location for the Notch, the software will ask the user to “Select the rotational 
direction point.” Select a pick point in the direction the part will fold when it is bent, or select the 
pick point where the cut will be placed to set the Rotational Direction Point to default settings. 

7. Select the Opening Angle
Next the software will ask the user to select the opening angle of the hole. Click the pick point, 
then verify the values in the Notch Dimensions box are still correct. Clicking the pick point may 
change some of the dimensions. 

8. Click Apply Hole
At the top of the Holes interface click APPLY HOLE. The Notch will appear in the 3D part 
interface. 
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9. Change Display
In the menu at the top of the interface, click Display and select Shaded to see the Notch 
applied to the material.

4.3.2 Transfer the Notch to Dragon CAM 

1. Select the Parts to Transfer
On the left hand side of the interface, under the Parts tab, ensure all the parts ready to be 
processed in the Dragon A400 are checked. 

2. Transfer to CAM
At the top of the interface, click the Transfer drop down menu. Click Dragon CAM.
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3. Open Dragon CAM
In the menu bar at the bottom of the computer screen click the Dragon icon. This will open 
Dragon CAM. Dragon CAM will display a Part Transfer interface showing the parts that were 
transferred from Dragon CAD. 

4. Open the Part Designer
Click the DESIGNER icon at the bottom of the interface. A Select Machine interface will open, 
ensure the desired Dragon machine is selected. Click OK. 

The parts will appear as a Design Project. The software will create multiple Design Project 
windows depending on how many parts are being created. 

5. Ensure the Notch Converted Correctly
Ensure the Notch appears correctly in the interface. Due to the close proximity of the cuts at 
the corners of the Notch, the software will sometimes choose a different cutting path. If this 
happens, navigate to the Edit Tab located under the Actions Tab, then click the Edit Cuts icon. 
Click on the cut in the part display to select the cut, then reduce the KERF OFFSET ADJUST. 
Click Apply Settings. Typically, reducing the Kerf Offset Adjust will alter the cut path enough 
to correct the cut. Alter the setting .01 at a time until the cut appears properly on the material 
display. 
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4.3.3 Adding a Diamond Tab
Cutting a notch removes material on three of four sides of the material. If the operator requires 
the material to retain its structural integrity, the user can add a Diamond Tab to the Notch. The 
Diamond Tab helps the material keep its rigidity and can be easily broken away when it comes 
time to bend the material. 

1. Transfer the Notched Part to Dragon CAM
Transfer the part to Dragon CAM. Open the part by clicking the Designer tab. This will open the 
part in Edit Flat. 

2. Navigate to the Edit Tab under Actions
Navigate to the Actions tab. Click the Edit tab, then click the Diamond Tab icon.
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3. Add a Diamond Tab
Mouse over the part in the Edit Flat display. A Diamond Tab shape will appear. Move the 
mouse cursor to move the Diamond Tab into the desired position. Once in position, left click 
the mouse to place the Diamond Tab on the part. The Diamond Tab will split the cut into two 
separate cuts. 

4. Adjust Dimensions of the Diamond Tab
With Diamond Tab chosen, the User can change the dimensions of the Diamond Tab, including 
Tab Width, Diamond Width, and Diamond Angle, to suit the project needs.
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5.1 Dry Running a Project

Dry running a job on the Dragon ensures the machine will perform all operations as 
programmed. This is helpful when initiating a new job, or when performing new operations. 
Ensuring the program will run as intended saves material and time. 

1. Open a Nested Project
With the project open as a Nesting Project, locate the Project Settings under the Setup Tab. 

2. Disable Ok to Move
In the Project Settings box, ensure the box next to Disable ‘OK to Move’ is checked. This will 
allow the machine to operate without the Torch achieving arc. 

Ensure the Plasma Unit is turned off. 

3. Run Project
At the top of the interface, click the RUN PROJECT icon. The Machine Control interface will 
open.

4. Home the Machine
If the machine is not Homed, click HOME ALL AXIS. 

05Miscellaneous Tutorials
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5. Click Start
Once the machine is Homed, click START. The Dragon will perform all operations in the Nest 
Project.

When the program is complete, if there are more pieces to cut in the Nesting Project, the 
Machine Control interface will show a green Complete light in the Status box. If the Nesting 
Project is complete and there are no more parts programmed to cut, the green Complete light 
will not appear. The machine is done with the program. If the Complete box is lit, click Run and 
the machine will continue running the Nesting Project. 

If the Complete box is lit, click START to set up the next stock length, and then press START 
again to initiate the second stock length.The machine will continue running the Nesting Project.

5.2 Using the Flip Feature

When any length of material is loaded into the Dragon machine, that piece of material will have 
approximately 13-inches of drop or deadzone, material the machine will not be able to process 
since it lies between the Toolhead and the Chuck. However, the Flip Feature can be used to 
make use of the deadzone material. It requires programming the Nesting Project to include a 
material flip, where the material is removed from the machine, flipped end-for-end, and then 
re-chucked. 

Important
To perform the Flip the part must extend more than halfway into the dead zone area 
when nested on the material.

1. Open or Start a Nesting Project
Load a part into the Nesting Project. The part will need to extend into the deadzone more then 
halfway. 

2. Activate Pause Before Reposition
Navigate to the Setup Tab. At the bottom of the Setup interface, check the “Pause Before 
Reposition” box. 

3. Add the Part to the Material
Next, navigate to the Parts Tab. Double click on the part to add it to the material.
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Note
The software will recognize the part is too long to fit on the material and will not allow the 
operator to add the part to the stick using the green or blue “+” icon.

4. Mark or Engrave Shift 1
When the part is added to the stick, the software will automatically apply a “Shift 1” mark to the 
part. Program the machine to either Mark or Engrave the “Shift 1” mark.

5. Cutting the Part
When the machine reaches the “Shift 1” actions, it will pause while the operator repositions the 
material. This requires removing the material, flipping it, and chucking it back into the machine. 
Line the shift mark up with the Laser Light. Once this is complete, the job can be restarted. 

5.2.1 Important Features

Material Cut To Length
If the material is already cut to the required length and end cuts are not necessary, the 
operator will be required to remove end cuts in Edit Flat. If material is pre-cut to the specified 
length and end cuts are not removed the software will display an “Export Failed” popup 
window. 

Chuck Settings
When performing a Flip, “Pass Through” cannot be chosen as an option in Chuck Settings. 

Start Cuts
If there are cuts with extreme angles, or cuts that will make the material difficult to fit into the 
Chuck, those should be programmed to take place after the Flip. Nest the end with the cut so it 
is placed in the Chuck at the start of the procedure.

If the material will be cut into two separate parts, ensure the smaller part is cut first, leaving a 
longer part in the machine.
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06Calibration

6.1 Calibration Overview

The Dragon is delivered to the customer from the Bend-Tech manufacturing facility fully 
calibrated. While the machine is delivered pre-calibrated, it is possible for the machine to lose 
calibration over time, or lose calibration due to servicing such as changing a tool or part. The 
purpose of this guide is to assist the Customer in understanding the calibration process of the 
Dragon. 

6.1.1 Calibration Points
The Dragon uses calibration points as references in its operation procedures. There are seven 
different calibration points in regard to Dragon A400 operation and five calibration points for the 
Dragon A250:

• Adjust Max Travel / Deadzone
• Adjust Chuck Zero
• Adjust Lifter (Dragon A400)
• Marker
• Engraver (Dragon A400)
• Torch
• Laser Light
• Powered Gate (Dragon A400)

Each of these can be calibrated individually or a full calibration can be performed to calibrate 
the entire machine.
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6.2 Dragon Calibration Wizard

Open the Machine Library. Select ‘Dragon’ or the specific machine that needs to be calibrated. 
Click the Wizard icon. The Dragon Calibration Wizard will display options to calibrate individual 
values in the machine, or the operator can choose ‘Perform Full Calibration’. 

Each calibration option is similar to each other. They all come with detailed on-screen 
instructions. Since a new machine is pre-caibrated at the Bend-Tech Factory, a full calibration 
is not needed, however, both the Torch and the Marker/Pen will need to be calibrated after the 
machine is assembled.

6.3 Torch Calibration 

1. Power on the Dragon
Ensure the Dragon is powered on as instructed by the wizard.

2. Start Mach3
When prompted, click START MACH to start Mach3. 

3. Computer Setup
Determine a left side and a right side of the machine based on where the computer is placed. 
Use the images provided as a reference.

Select which side of the machine the computer is placed on. Click NEXT.
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4. Jog the Trolley
Jog the Trolley so that is is near the Tail of the machine. This will save time when homing in the 
next step. Click NEXT after the Trolley is in position.

! Caution !
Avoid moving the Trolley past the homing switch on the Rail. Damage to the Trolley, 
homing switch and Rail could occur. 

5. Home the Dragon
Click the image to begin the homing process. While the Dragon is homing, a warning will 
appear on the screen stating that the “Machine is currently homing, please wait.” Once the 
warning disappears, click NEXT.

6. Select the Calibration Material
Select ROUND or SQUARE for the calibration material. Ensure that the stock length is long 
enough to secure in the Chuck and extend past the Laser Light. Click NEXT.

7. Load the Material
Click BEGIN LOAD. This will move the Dragon into Load Position. Enter the outside diameter 
(OD) of the calibration material into the text box. After loading the material, click NEXT.
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8. Mark the Laser Light Location
Click MOVE LASER to move the Laser Light into position. Next, mark the Laser Light location 
with a marker. Click NEXT, after marking the Laser Light position.

9. Position the Torch
Click MOVE TORCH. Use the positional buttons to position the Torch centered over the mark 
made in the previous step. Click NEXT.
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10. Pierce a Hole
Click PIERCE HOLE. A warning will appear, click OK. The Dragon will pierce a hole. Click 
NEXT after the Dragon is finished moving.

11. Verify Positions
Verify the pierce hole is centered over the Laser Light. Use the positional buttons to adjust the 
position as needed. Click NEXT.

12. Calibration Complete
Click DONE or close out of the Calibration Wizard to complete the Torch Calibration.
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6.4 Marker/Pen Calibration

1. Power on the Dragon
Ensure the Dragon is powered on as instructed by the wizard.

2. Start Mach3
When prompted, click START MACH to start Mach3. 

3. Computer Setup
Determine a left side and a right side of the machine based on where the computer is placed. 
Use the images provided as a reference.

Select which side of the machine the computer is placed on. Click NEXT.

4. Jog the Trolley
Jog the Trolley so that is is near the Tail of the machine. This will save time when homing in the 
next step. Click NEXT after the Trolley is in position.

! Caution !
Avoid moving the Trolley past the homing switch on the Rail. Damage to the Trolley, 
homing switch and Rail could occur. 

5. Home the Dragon
Click the image to begin the homing process. While the Dragon is homing, a warning will 
appear on the screen stating that the “Machine is currently homing, please wait.” Once the 
warning disappears, click NEXT.

6. Select the Calibration Material
Select ROUND or SQUARE for the calibration material. Ensure that the stock length is long 
enough to secure in the Chuck and extend past the Laser Light. Click NEXT.
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7. Load the Material
Click BEGIN LOAD. This will move the Dragon in to Load Position. Enter the outside diameter 
(OD) of the calibration material into the text box. After loading the material, click NEXT.

8. Mark the Laser Light Location
Click MOVE LASER to move the Laser Light into position. Next, mark the Laser Light location 
with a marker. Click NEXT, after marking the Laser Light position.
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9. Position the Marker
Click MOVE PEN. Use the positional buttons to position the Marker centered over the mark 
made in the previous step. Click NEXT.

10. Calibration Complete
Click DONE or close out of the Calibration Wizard to complete the Marker/Pen Calibration.





Bend-Tech LLC

729 Prospect Ave. Osceola, WI 54020
1-651-257-8715

sales@bend-tech.com
www.bend-tech.com


